
930XC-20C • 930XC-20M
930XC-30F • 930XC-30P

Handheld OTDRs

52079877 REV 2 © 2021 Tempo Communications Inc. 02/2021

 
INSTRUCTION MANUAL

 
Read and understand all of the instructions  
and safety information in this manual  
before operating or servicing this tool.

Register this product at www.TempoCom.com



930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P

Tempo Communications Inc. 1390 Aspen Way • Vista, CA 92081 USA • 800-642-21552

Table of Contents

Preface 5
Description .............................................................................................................................. 5
Safety ..................................................................................................................................... 5
Purpose of This Manual ........................................................................................................... 5
Warranty .................................................................................................................................. 5

Important Safety Information 6

Section 1. Introduction 9

Section 2. Basic Operation 10
Instrument Interface Description ............................................................................................ 10
Use of Batteries ..................................................................................................................... 10
 Auto Off Mode .................................................................................................................... 10
 Recharging ......................................................................................................................... 10
Keypad Functions .................................................................................................................. 11

Section 3. Basic OTDR Information 12
Principle of OTDRs ................................................................................................................. 12
Basic Definition and Classification of Events ........................................................................... 12
 Reflection Events ................................................................................................................ 12
 Non-reflection Events .......................................................................................................... 12
 Inspection of Events ........................................................................................................... 12
Measurement Application....................................................................................................... 13
 Measurement Contents ....................................................................................................... 13
 Trace Analysis .................................................................................................................... 13
Trace Display Screen .............................................................................................................. 13
 Trace Display Window ......................................................................................................... 13
 Information Window ........................................................................................................... 14
  Measurement Trace Parameters....................................................................................... 14
  Events List ...................................................................................................................... 14
  Marker A/B Information ................................................................................................... 15
  Fiber Information ............................................................................................................ 15
 Menu Bar and Icons ............................................................................................................ 16
 Parameter Configuration ..................................................................................................... 16
  Definitions of Measurement Parameters ........................................................................... 17
  Range Configuration ........................................................................................................ 17
  Pulse Width Configuration................................................................................................ 18
  Average Time Configuration ............................................................................................. 18
  Wavelength Configuration ................................................................................................ 18
  Measurement Mode Configuration ................................................................................... 19
  Power Meter, Laser Source, and VFL Configuration ............................................................ 19
  Length Units ................................................................................................................... 20
  Index of Refraction (IOR) Configuration ............................................................................ 20
  Scatter Coefficient Configuration ..................................................................................... 20 
  Non-reflection Threshold Configuration ............................................................................ 21
  Reflection Threshold Configuration ................................................................................... 21
  End Threshold Configuration ............................................................................................ 22



930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P

3Tempo Communications Inc. 1390 Aspen Way • Vista, CA 92081 USA • 800-642-2155

  Delete File ....................................................................................................................... 22
  Format Memory ............................................................................................................... 23
  Time Configuration .......................................................................................................... 23
  Auto Off Configuration ..................................................................................................... 23
  Language Configuration ................................................................................................... 24
  Contrast Adjustment of LCD ............................................................................................ 24
  Color Mode Setting.......................................................................................................... 24
  Default Setting ................................................................................................................ 25
  Help ............................................................................................................................... 25
Battery Recharge Status ......................................................................................................... 26

Section 4. Trace Measurement and Processing of Existing Traces 27
Graphical User Interface (GUI) Instructions ............................................................................. 27
Trace Measurement ............................................................................................................... 27
 Setup ................................................................................................................................. 28
 Auto Trace Measurement .................................................................................................... 28
 Manual Trace Measurement ................................................................................................ 29
 Live Traffic Warning ............................................................................................................ 29
 Reasons for Trace Measurement Failures ............................................................................ 29
Information Window ............................................................................................................... 29
 Switching between Information Window Items ..................................................................... 29
 Reviewing Events List ......................................................................................................... 29
 Reviewing Marker A/B Information ...................................................................................... 29
  Switching between Marker A/B ........................................................................................ 29
  Information between Marker A/B ..................................................................................... 30
Zoom a Trace ......................................................................................................................... 30
 Zoom out Trace Horizontally ............................................................................................... 30
 Zoom in Trace Horizontally.................................................................................................. 30
 Zoom out Trace Vertically ................................................................................................... 30
 Zoom in Trace Vertically ..................................................................................................... 30
 Zooming Shortcuts ............................................................................................................. 30
Re-analyze a Trace ................................................................................................................. 30
Save a Trace .......................................................................................................................... 30
Browse Saved Traces ............................................................................................................. 31
Alter Measurements in Realtime Testing ................................................................................. 31
Power Meter, Laser Source, and VFL Settings .......................................................................... 32
 Optical Power Meter Settings .............................................................................................. 32
 Zeroing the Optical Power Meter ......................................................................................... 32
 Stabilized Laser Source Settings ......................................................................................... 33
 Visible Fault Locator Settings .............................................................................................. 33
Link Viewer ............................................................................................................................ 34
 Display Mode ..................................................................................................................... 34
 Events Summary ................................................................................................................. 35
 Pass/Fail Setup .................................................................................................................. 35 
 Pass/Fail Settings .............................................................................................................. 36
Macrobend Analysis ............................................................................................................... 36

Section 5. Calibration and Maintenance 38
Calibration Requirements ....................................................................................................... 38
Maintenance and Replacement of Batteries............................................................................. 38
Cleaning ................................................................................................................................ 39



930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P

Tempo Communications Inc. 1390 Aspen Way • Vista, CA 92081 USA • 800-642-21554

 Before Cleaning .................................................................................................................. 39
 Cleaning Interfaces and Connectors .................................................................................... 39
 Tools for Cleaning Interfaces and Connectors ...................................................................... 39
 Prrocedure for Cleaning Interfaces and Connectors .............................................................. 39

Section 6. Specifications 40
 Stabilized Laser Source Module .......................................................................................... 41
 Optical Power Meter Module ............................................................................................... 41

Section 7. Calibration and Maintenance 42
Software Installation .............................................................................................................. 42
 Computer System Requirements ......................................................................................... 42
 Installation ......................................................................................................................... 42
Software GUI ......................................................................................................................... 42
 Graphical User Interface (GUI) ............................................................................................. 42
 Menu, Tool Bar, and Status Bar ............................................................................................ 42
  File (F) ............................................................................................................................ 43
  Edit (E) ........................................................................................................................... 43
  View (V) .......................................................................................................................... 43
  OTDR (O) ........................................................................................................................ 44
  Window (W) .................................................................................................................... 45
  Help (H) .......................................................................................................................... 45
 Information Subwindows .................................................................................................... 46
  Trace Display Window ..................................................................................................... 46
  Events List Window ......................................................................................................... 46
  Parameter Window .......................................................................................................... 47
  Fiber Section Information Window .................................................................................... 47
  Fiber Chain Information Window ...................................................................................... 47
Software Functions ................................................................................................................ 48
 Upload Trace Data .............................................................................................................. 48
  Option 1:  ........................................................................................................................ 48
  Option 2:  ........................................................................................................................ 48
 Browse Traces .................................................................................................................... 49
  Tool Bar .......................................................................................................................... 49
  Open Trace File ............................................................................................................... 50
  Zoom in and out of Trace ................................................................................................. 50
  Review Trace Information ................................................................................................ 50
 Save Trace ......................................................................................................................... 52
 ASCII Format Output ........................................................................................................... 52
 Edit Optical Fiber Information .............................................................................................. 52
 Revise Events List ............................................................................................................... 53
  Add Event ....................................................................................................................... 53
  Revise Event ................................................................................................................... 53
  Delete Event .................................................................................................................... 53
 Printing .............................................................................................................................. 54
  Printing Options .............................................................................................................. 54
  Printing Setup ................................................................................................................. 54
  Printing Preview .............................................................................................................. 55
  Printing ........................................................................................................................... 56
  Batch Edit ....................................................................................................................... 56
  Batch Print ...................................................................................................................... 56
  Batch Print Preview ......................................................................................................... 57
  Exit Software .................................................................................................................. 58



930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P

5Tempo Communications Inc. 1390 Aspen Way • Vista, CA 92081 USA • 800-642-2155

Preface

Description
The Tempo Communications fiberTOOLS™ 930XC instruments are handheld Optical Time Domain Reflectometers (OTDRs) for 
measuring the specifications of single-mode or multi-mode optical fiber.

• The 930XC-20C measures optical fiber at 1310 nm and 1550 nm.
• The 930XC-20M measures optical fiber at 850 nm and 1300 nm.
• The 930XC-30F measures optical fiber at 1310 nm, 1550 nm, and 1625 nm.
• The 930XC-30P measures optical fiber at 1310 nm, 1490 nm, and 1550 nm.
  Included with the 930XC instruments are the following:
• USB and serial data transfer cables
• Power adapter
• Vehicle adapter power cord
• Trace Viewer software installation disk
• Instruction manual
• Soft carrying case

Safety
Safety is essential in the use and maintenance of Tempo Communications tools and equipment. 
This instruction manual and any markings on the tool provide information for avoiding hazards and unsafe practices related to 
the use of this tool. Observe all of the safety information provided. 

Purpose of This Manual
This instruction manual is intended to familiarize all personnel with the safe operation and maintenance procedures for the 
Tempo Communications 930XC handheld OTDRs. 
Keep this manual available to all personnel. Replacement manuals are available upon request at no charge.

Warranty
Tempo Communications Inc. warrants to the original purchaser of these goods for use that these products will be free from 
defects in workmanship and material for one year. This warranty is subject to the same terms and conditions contained in 
Tempo Communication’s standard one-year limited warranty.
For all Test Instrument repairs, contact Customer Service at 800-642-2155 to request a Return Authorization.
For items not covered under warranty (such as items dropped, abused, etc.), a repair cost quote is available upon request.
Note: Prior to returning any test instrument, please check replaceable batteries or make sure the battery is at full charge.
All specifications are nominal and may change as design improvements occur.
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Important Safety Information

SAFETY 
ALERT 
SYMBOL

This symbol is used to call your attention to hazards or unsafe practices which could result in an 
injury or property damage. The signal word, defined below, indicates the severity of the hazard. 
The message after the signal word provides information for preventing or avoiding the hazard.

Immediate hazards which, if not avoided, WILL result in severe injury or death.

Hazards which, if not avoided, COULD result in severe injury or death.

Hazards or unsafe practices which, if not avoided, MAY result in injury or property damage.

Read and understand all of the instructions and safety information in this 
manual before operating or  servicing this tool.
Failure to observe this warning could result in severe injury or death.

Electric shock hazard:

• Do not operate in an explosive atmosphere such as in the presence of flammable gases or 
fumes.

• Before applying power, verify that the unit is set to match the available line voltage.

Failure to observe these warnings could result in severe injury or death.
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Important Safety Information (cont’d)

Electric shock hazard:

• Fuse replacement should be performed by Tempo qualified personnel.

• Do not use repaired fuses or short-circuited fuse holders.

Failure to observe these warnings could result in severe injury or death.

The 930XC instruments are laser devices
conforming to the requirements of CDRH,
CFR 1040, Subchapter J. While there is no
potential for eye damage due to unaided
direct exposure, users should always avoid
looking directly into the output port. The
use of optical viewing instruments, such
as microscopes, magnifiers, etc., should
always be avoided. The use of such devices
around active fibers can focus an intense
beam of light energy onto the retina of
the eye, which can result in permanent
damage.

Laser hazard:

• When performing measurements on fiber optic systems, avoid eye exposure to any open-
ended fibers, optical connectors, optical interfaces, or other sources because they may be 
connected to active laser transmitters.

• Do not look into the optical port when a source is turned on.

• Avoid looking at the free end of a test fiber, i.e., the end not connected to the instrument. If 
possible, direct the free end toward a non-reflective surface.

Failure to observe these precautions may result in injury.

LASER LIGHT
DO NOT STARE INTO BEAM

CLASS 1 LASER PRODUCT



930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P

Tempo Communications Inc. 1390 Aspen Way • Vista, CA 92081 USA • 800-642-21558

Important Safety Information (cont’d)

Electric shock hazard:

• Do not expose batteries to fire or intense heat. Do not open or mutilate batteries. Avoid 
touching the electrolyte in the batteries, which is corrosive and may cause damage to eyes or 
skin.

• Do not open the case of the unit for any reason. It contains no user-serviceable parts.

• Use this unit for the manufacturer’s intended purpose only, as described in this manual. Any 
other use can impair the protection provided by the unit.

Failure to observe these precautions may result in injury and may damage the unit.

Instrument damage hazard:
• Make sure that the optical fiber or cable is not in use and there is no laser beam in the fiber 

before testing with this unit.
• Do not leave the unit in direct sunlight or near direct sources of heat.
• Protect the unit from strong impacts or shock.
• Do not immerse the unit in water or store in areas with high humidity.
• When necessary, clean the case, front panel, and rubber cover with a damp cloth. Do not use 

abrasives, harsh chemicals, or solvents.
• Replace the protective dust cap when the unit is not in use.
• Store the unit and interface adapters in a cool, dry, and clean place.

Failure to observe these precautions may result in injury and may damage the unit.

Electric shock hazard:

• Do not expose the unit to extremes in temperature or high humidity. Refer to “Specifications.”

• Turn the unit off, disconnect from power, and make sure the laser source is off before 
cleaning.

Failure to observe these precautions may result in injury and may damage the unit.
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Section 1. Introduction
Tempo’s 930XC handheld OTDRs can make an assessment of one single optical fiber or a whole optical fiber chain. In addition, 
the user can directly observe loss and events distribution of an optical fiber chain.
The 930XC tools check the transmission quality of optical fiber through the measurement of backscatter. Standard 
organizations like the International Telecom Union (ITU) define backscatter as an effective analysis means to measure optical 
fiber loss. Backscattering is also the only effective way of connector inspection, which can be applied to measure the length of 
optical fiber.
The 930XC OTDRs operate by reviewing events in optical fiber (for example, irregularities and connectors). These tools can 
help identify irregularities in optical fiber, locate them, and measure their attenuation, relevant loss, and homogeneity.
These tools are easy-to-use, small, and compact with large LCD displays and graphical interfaces. They can save and transfer 
the measurement curves data to a PC by using the provided Trace Viewer software for further analyzing, reporting, and 
printing.

Basic applications:
• Measure the length of optical fiber and cable.
• Measure the distance between two points on optical fiber and cable.
• Locate faults and ruptures of optical fiber and cable.
• Display distribution curve of optical fiber and cable loss.
• Measure attenuation coefficient of optical fiber and cable.
• Measure loss between two points on optical fiber and cable.
• Measure loss of tie-ins.
• Measure reflection of reflection events of optical fiber and cable.
• The 930XC-30F can measure live optical fibers at 1625 nm.

For a specific event (transmission quality changed due to faults caused by fusion splicing, connector, bending, etc.), the 
following measurements can be carried out:

• For each event: Distance, loss, and reflection.
• For each section of optical fiber: Length and loss of dB or dB/unit length.
• For the whole optical fiber chain: Length and loss of dB.

Additional features:
• Large LCD display with auto or manual adjustment of contrast.
• Backlight LCD display supports night operation.
• Easy operation with trace graphic display.
• Trace storage function.
• RS-232 and USB data upload ports.
• Trace Viewer software for analyzing and reporting previously stored data.
• Auto off function to conserve battery life.
• DC/AC power supply.
• Macrobend analysis.
• Link Viewer for automated Pass/Fail analysis.
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Section 2. Basic Operation
This section describes the basic operation of the 930XC instruments. Specific operations are explained in detail in Section 3 of 
this manual. 

Instrument Interface Description

1. Charge Indicator: When lit, measurement power is charging.

2. Power Indicator: When lit, measurement power is on.

3. AC Power Jack: Power adapter jack requirements are 13.8 VDC at 1.2 A.

4. Data Transfer Ports: USB and RS-232 interfaces to transfer saved traces in the instrument to a PC for further analysis 
   with Trace Viewer software (provided).

5. Fiber Optic Output for OTDR or 1625 nm live fiber, and VFL (visual fault locator): Connector is used for 
   the OTDR interface.

6. Invisible Laser Caution: Do not look directly at the optical output or stare at the laser beam.

7. OPM Optical Power Meter

Use of Batteries
The 930XC tools use a NiMH battery.

 Auto Off Mode
• The instrument will enter auto off mode when there is insufficient power during operation. The low power icon will be 
  displayed on the LCD.
• If unused for a long time, causing insufficient power, the instrument will enter auto off mode several seconds after
  powering on in order to protect the batteries in case of excessive discharging. The internal battery should be recharged 
  immediately through the adapter.

 Recharging
• Perform a quick charge first, and then switch to trickle charge after the voltage reaches a predefined figure. Quick charge 
  temperature is 5 °C to 45 °C (41 °F to 113 °F), and trickle charge temperature is 0 °F to 55 °C (32 °F to 131 °F). Battery 
  will not be fully charged or may be damaged if the charging temperature is beyond the above range, which may shorten 
  battery life.
• A quick charge takes 3 hours.

11930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P Instruction Manual
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This section describes the basic operation of the 930XC instruments. Specific operations are 
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Instrument Interface Description
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RS-232

OTDR

OPM VFL
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Figure 2-1. Interface Panel

1. Charge Indicator: When lit, measurement power is charging.

2. Power Indicator: When lit, measurement power is on.

3. AC Power Jack: Power adapter jack requirements are 13.8 VDC at 1.2 A.

4. Data Transfer Ports: USB and RS-232 interfaces to transfer saved traces in the instrument to 
a PC for further analysis with Trace Viewer software (provided). 

5.	 Fiber	Optic	Output	for	OTDR	or	1625	nm	live	fiber,	and	VFL	(visual	fault	locator): 
Connector is used for the OTDR interface.

6.	 Invisible	Laser	Caution:	Do not look directly at the optical output or stare at the laser beam.

7. OPM Optical Power Meter
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Keypad Functions

1. On/Off: Press to turn power on or off to the instrument.
2. Run/Stop:

• Under GUI, press to start measurement.
• While testing, press to stop measurement.

3. Enter:
• Under GUI, press to confirm the current operation.
• Use with the Shift key to zoom out trace vertically.

4. pq (up and down) arrows:
• Move menu bar in menu operation.
• Highlight the icon to be selected.
• Adjust parameter in parameter configuration.
• Use q with the Shift key to browse up the events list.
• Use p with the Shift key to zoom in trace vertically.

5.  t u (left and right) arrows:
• Select parameter to be adjusted in parameter configuration.
• Move marker left or right in trace operation.
• Turn pa ge while in Help submenu.
• Use with the Shift key to zoom out or zoom in trace horizontally.

6.  arrow:
• Read Help menu when power on.
• Cancel the current operation.
• Exit menu configuration.
• Switch between information windows.
• Use with the Shift key to browse down the events list.

7. Shift:
• Under GUI, press to return a trace to original size without any zoom.
• Activate the integration function by pressing this key together with other keys.

2

5

6

1

5

7

4

3

4

Figure 2-2. 930XC Keypad
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Section 3. Basic OTDR Information
Principle of OTDRs
An OTDR (Optical Time Domain Reflectometer) is a measurement instrument for identifying optical fiber transmission features. 
The OTDR is used to measure the overall attenuation of a fiber optic link and to provide details relating to the position of 
each event in that link. Events include splices, connectors, bends, and optical components. Its non-destructive, single-
ended connection and rapid measurement have made the OTDR an indispensable tool for manufacturing, construction, and 
maintenance of optical fiber links.
The faults and heterogeneity of optical fiber itself cause Rayleigh scattering of light transmitted in optical fiber. Part of the light 
pulse is scattered in the reverse direction, and this is called Rayleigh backscattering, which actually provides attenuation details 
relating to fiber length.
Information relating to distance is obtained through time information (thus “time domain” in the name OTDR). Fresnel reflection 
occurs at the boundary between two media of different IOR (for example, connections of faults, connectors, or optical fiber end). 
This reflection is used to locate the discontinuous points on optical fiber. The magnitude of reflection depends on the difference
between IOR and the smoothness of boundary.
An OTDR sends out a light pulse into the optical fiber and receives reflections of events and backscattering power of the pulse in 
time. Locations will be displayed on the LCD. The y-axis is the dB value of backscattering power, and the x-axis is the distance.

Basic Definition and Classification of Events
Events refer to any abnormal points causing attenuation or sudden change of scattering power besides the normal scattering of 
optical fiber, which include losses such as bending, connections, and ruptures.
Event points displayed on the LCD are abnormal points that cause traces to deviate from a straight line.
Events can be classified as reflection events or non-reflection events.

Reflection Events
When some pulse energy is scattered, reflection events occur. When reflection events occur, a peak is displayed on the trace 

(Figure 3-1).

Non-reflection Events

Figure 3-2. Non reflection Event

Figure 3-1. Reflection Event
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When some pulse energy is scattered, reflection events occur. When reflection events occur, a peak is displayed on the trace 
(Figure 3-1).

Measurement Application
The 930XC instruments display power relating to the distance of returning signals. This information can be used to identify the 
main properties of an optical fiber chain.

Measurement Contents
• Event location (distance), end, or rupture of optical fiber chain.
• Attenuation coefficient of fiber.
• Loss of a single event (for example, one optic tie-in), or total loss from upper end to end.
• Range of a single event like reflection of connectors (or grade of reflection).
• Auto measurement of cumulative loss of a single event.

Trace Analysis
The trace analysis of the 930XC OTDR is fully automatic. The trace locates:

• Reflection events of connections and mechanical tie-ins.
• Non-reflection events.
• End of optical fiber.
• Through scanning the first loss event that is larger than the end threshold, identifies the end of optical fiber.
• Events list: Event type, loss, reflection, and distance.

Trace Display Screen
The trace displays on the 930XC screen (Figure 3-3).
Trace Display Window
This window displays the trace after one measurement.
Definition of trace: After one measurement, the reflection power diagram will be displayed as a distance function. This diagram 
is referred to as trace.

Figure 3-3. Trace Display Screen

Figure 3-4. Traces and Coordinates
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The trace of the 930XC displays measurement results in a graphic form. The y-axis represents the power while the x-axis 
represents the distance (Figure 3-4).
Information Window
The contents of this window are measurement parameters, events list, marker A/B, and analysis parameters.

Measurement Trace Parameters
Important measurement and analysis parameters are displayed in the information window (Figures 3-5a and 3-5b).
For definitions and configurations of items in Figure 3-5a (average time, sample distance, range, IOR, wavelength, and pulse 
width) as well as definitions of items in Figure 3-5b (date, reflection threshold, non-reflection threshold, end threshold, and 
scattering coefficient), refer to “Parameter Configuration” in this section of the manual.
Events List

The events list indicates the location of events inspected. Any defined posts will be displayed in the events list (for example, a 
non-reflection event such as a fusion splice or a reflection event such as a connector) (Figure 3-6).

• No.: Event sequence number.
• Four types of events: begin end; reflection event; fiber end; attentuation event.
• Location: Distance from beginning point to event.
• Refl.: Magnitude of reflection.
• Ins.L.: Loss of inserted event.

Figure 3-5b. Analysis Trace ParametersFigure 3-5a. Measurement Trace Parameters

Figure 3-6. Events List
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• Attn.: Attenuation characteristic from one event point to the current event.
• Cum.L.: Cumulative loss, calculating from beginning point to the current event.

Marker A/B Information
A marker is used to mark and analyze a single event, trace section, and distance. Distance, attenuation, and loss at a marker or 
between markers will be displayed in marker information (Figure 3-7).
The following parameters are measured between marker A and B. Changing either marker will change the record accordingly.

• A-B: Distance between two markers.
• 2Pt. Loss: Loss between two markers; power difference between two markers.
• 2Pt. Atten: 2 points loss of unit length.

The specific operations of the above items are explained in more detail later in this manual.

Figure 3-8. Fiber Information

Figure 3-7. Marker A/B Information
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Fiber Information
Fiber information includes total attenuation, length, and loss of the tested fiber (Figure 3-8).

Menu Bar and Icons
Notes:

• Under the Help menu, only numbers 1 and 3 are operational.
• In the process of measurement, all functions on the menu bar will be disabled.
• Numbers 3, 4, 5, 6, 7, 8, and 9 are tools for trace analysis. Numbers 10 and 11 are tools for reviewing events list.
• Number 1 is explained in the next section, “Parameter Configuration.”

Parameter Configuration
Correct parameter configuration is necessary for accurate measurements.
Use p and q to highlight  (i.e., parameter configuration on the menu bar), and then press Enter (Figure 3-9).
Press   to exit.

Figure 3-9. Parameter Configuration

1

2

3

4 Re-analyze the trace

5 Zoom out trace horizontally
6 Zoom in trace horizontally
7 Zoom out trace vertically
8 Zoom in trace vertically
9 Switch between markers

10 Review events list upward
11 Review events list downward
12 Battery power indicator

Open file

Save file
Parameter configuration

No. Icons Description
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Definitions of Measurement Parameters

Range Configuration
Generally, the range is set according to the actual length of optical fiber in order to insure the accuracy of the measurement.
Under the parameter configuration menu use p and q to highlight “Range.” Press Enter to select a range (Figure 3-10).
Press to  exit.

Use p and q to select an adequate range. Press Enter to confirm.
Notes:
• “Auto” means automatic measurement. When this function is selected, the instrument automatically selects an adequate 
  range and pulse width for the measurement. The process of measurement does not require any intervention by the user.
• “Auto” is the default setting.

Figure 3-9. Range Configuration

Range
Pulse Width
Average Time Select suitable testing time
Wavelength Select laser wavelength for measurement
Measurement Mode Select mode for measurement
PM/LS
Length Units

Optical power meter, stabilized laser source, and VFL
Select units of measurement

IOR

Threshold
Events whose insertion loss is ≥ the threshold displayed here

End Threshold First event with insertion loss ≥ the threshold is considered the end of

Delete File Delete stored trace data in the instrument
Time Show current system time
Auto Off Enable or disable auto off function
Lang./ Choose language
LCD Contrast Adjust contrast of LCD
Color Mode Select suitable color setting for display
Load Default Set all parameters to factory setting
Help
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Pulse Width Configuration
The selection of pulse width affects the dynamic range and resolution of the measurement. With a narrow pulse width there will 
be higher resolution and smaller deadzone; however, the dynamic range will be decreased. A wide pulse width will bring higher 
dynamic range and measure comparatively longer distance, but resolution and deadzone will be increased. Therefore, users 
should make the choice between dynamic range and deadzone.
The options for pulse width will change according to the distance range selected.
Under the parameter configuration menu use p and q to highlight “PulseWidth.” Press Enter to select a value (Figure 3-11).
Press to exit.

Use p and q to highlight the pulse width. Press Enter to confirm.
Notes:

• “Auto” is the default setting.
• When the range is set to “Auto,” the pulse width automatically is set to “Auto.”

Average Time Configuration
Average time will affect the SNR directly. The longer the average time is, the higher SNR is, as well as dynamic range. Therefore, 
when measuring long-distance optical fiber, a long average time should be selected in order to review events at the long-
distance end.
Under the parameter configuration menu use p and q to highlight “Avg. Time.” Press Enter to confirm (Figure 3-12).
Press to exit.

Use p and q to highlight the pulse width. Press Enter to confirm.
Notes:

• There are five levels of predefined average time: 15 s, 30 s, 1 min, 2 min, and 3 min.
• The default setting is “30 s.”

Wavelength Configuration
Under the parameter configuration menu use p and q to highlight “Wavelength.” Press Enter to change the
wavelength (Figure 3-13).

Figure 3-11. Pulse Width Configuration

Figure 3-12. Average Time Configuration
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Measurement Mode Configuration
There are two kinds of measurement mode: averaging and realtime. Under realtime mode the 930XC will undertake realtime 
measurement for the connector of exterior fiber and refurbish the measured trace. While under realtime mode, press Run/Stop 
to stop; otherwise it will measure continuously. Under Averaging mode the tool will average the data within the measure time, 
which is set by the user. When exceeding the set time, it will stop automatically and display the result. In general, averaging is 
the preferred mode.
Under the parameter configuration menu use p and q to highlight “Meas. Mode.” Press Enter to select “Averaging” or 
“Realtime” mode (Figure 3-14). Press to exit.

Power Meter, Laser Source, and VFL Configuration
Under the parameter configuration use p and q to highlight “PM/LS” and press Enter to enter PM/LS interface (Figure 3-15). 
Refer to “Power Meter, Laser Source, and VFL Settings” in Section 4 for details.

Figure 3-13. Wavelength Configuration

Figure 3-14. Measurement Mode Configuration

Figure 3-15. Power Meter and Laser Source Configuration
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Length Units
Under the parameter configuration menu use p and q to highlight “Length Units.” Press Enter to select the desired units of 
measurement (Figure 3-16). Press  to exit.

Index of Refraction (IOR) Configuration
Because IOR is a key factor affecting the speed of laser transmission in optical fiber, the IOR configuration has a direct impact 
on the accuracy of measurement. In general, the IOR parameter is provided by the optical fiber manufacturer, and it can be set to 
the accuracy of four digits after the decimal point between 1.0 and 2.0.
Under the parameter configuration menu use p and q to highlight “IOR.” Press Enter to enter a value (Figure 3-17).
Press   to exit.

Use t and u to adjust the position of the highlighted area. Use p and q to change the digits. After setting, press Enter to 
confirm.
Scatter Coefficient Configuration
Scatter coefficient determines the value of backscatter power. This configuration affects the calculation of reflection value.
Under the parameter configuration menu use p and q to highlight “Scat. Coef.” Press Enter to enter a value (Figure 3-18). 

Figure 3-16. Length Units

Figure 3-17. IOR Configuration

Figure 3-17. IOR Configuration
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Press   to exit.
Use t and u to adjust the position of the highlighted area. Use p and q to change the digits. After setting, press Enter to 
confirm.
Non-reflection Threshold Configuration
This configuration has direct impact on the listing of insertion loss events. Only events ≥ to this threshold will be listed.
Under the parameter configuration menu use p and q to highlight “Nrefl. Thre.” Press Enter to enter a value (Figure 3-19).
Press   to exit.

Use t and u to adjust the position of the highlighted area. Use p and q to change the digits. After setting, press Enter to 
confirm.
Note: The default setting is “0.20 dB.”
Reflection Threshold Configuration
This configuration has direct impact on reflection events listing. Only reflection events ≥ to this threshold will be displayed in the 
events list.

Under the parameter configuration menu use p and q to highlight “Refl. Thre.” Press Enter to enter a value (Figure 3-20).
Press   to exit.
Use t and u to adjust the position of the highlighted area. Use p and q to change the digits. After setting, press Enter to 
confirm.
Note: The default setting is “–52.00 dB.”

Figure 3-19. Non-reflection Threshold Configuration

Figure 3-20. Reflection Threshold Configuration
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End Threshold Configuration
This threshold is the end threshold of optical fiber. If the end threshold equals 3.0 dB, then the first event with insertion loss ≥ 3 
dB will be considered the end of the optical fiber. If the value is set to 0 dB, there will be no end threshold.
Under the parameter configuration menu use p and q to highlight “End Thre.” Press Enter to enter a value (Figure 3-21).
Press   to exit.

Use t and u to adjust the position of the highlighted area. Use p and q to change the digits. After setting, press Enter to 
confirm.
Note: The default setting is “03.00 dB.”
Delete File
This function deletes saved traces. 
Under the parameter configuration menu use p and q to highlight “Delete File.” Press Enter to enter (Figure 3-22).
Press   to exit.

Use p and q to choose the files to delete, and press Enter to confirm. Or use the arrow keys to choose “SelAll,” and press Enter 
to select all files.
One or several files can be deleted at a time. Use the arrow keys to select “Delete.” Press Enter, and choose “Yes” to delete or 
“No” to not delete. Choosing “Cancel” will exit the Delete menu.

Figure 3-21. End Threshold Configuration

Figure 3-22. Delete File
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Format Memory
Press format memory to format the internal memory. 

Time Configuration
Time configuration is used to change system time. 
Under the parameter configuration menu use p and q to highlight “Time (y-m-d).” Press Enter to change (Figure 3-23).

Press   to exit.
Use t and u to adjust the position of the highlighted area. Use p and q to change the digits. After setting, press Enter to 
confirm.
Auto Off Configuration
This function conserves battery power. When auto off is enabled, the instrument will automatically power off when idle for 5 
minutes. 

Figure 3-22a. Format Memory

Figure 3-23. Time Configuration

Figure 3-23. Time Configuration
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Under the parameter configuration menu use p and q to highlight “Auto Off.” Press Enter to switch between “Off” and “On” 
(Figure 3-24). Press   to exit.
Note: The default setting is “On.”
Language Configuration

There are two language options: English and Chinese. 
Under the parameter configuration menu use p and q to highlight “Lang./  .” Press Enter to switch the language
(Figure 3-25). Press   to exit.
Contrast Adjustment of LCD
The contrast of the LCD can be adjusted. 

Under the parameter configuration menu use p and q to highlight “LCD Contrast,” Press Enter to adjust (Figure 3-26).
Press   to exit.
Use t and u to adjust the contrast. After adjusting, press Enter to confirm.
Color Mode Setting
This setting changes the color scheme of the display. 

Figure 3-25. Language Configuration

Figure 3-26. Contrast Adjustment of LCD

Figure 3-27. Color Mode Setting
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Under the parameter configuration menu use p and q to highlight “Color Mode.” Press Enter to choose a different mode 
(Figure 3-27). Press   to exit.
Use p and q to highlight the desired color mode setting. Press Enter to confirm the selection.
Default Setting
This function is used to set the OTDR parameters to factory settings. These parameters include: range, pulse width, average 
time, IOR, non-reflection threshold, reflection threshold, end threshold, and scatter coefficient. 

Under the parameter configuration menu use p and q to highlight “Load Default.” Press Enter to choose a different mode 
(Figure 3-28). Press   to exit.
Use p and q to highlight “Yes” or “No.” Press Enter to confirm.
Help
The Help function provides access to the quick reference screen. 
Under the parameter configuration menu use p and q to highlight “Help.” Press Enter to display the quick reference screen 
(Figure 3-29). Press   to exit.

Figure 3-28. Default Setting

Figure 3-29. Help
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Battery Recharge Status
When the 930XC is powered off and powered through the AC/DC adapter, the “CHARGE” indicator on the interface panel    
(Figure 2-1) will be lit. When the battery is fully recharged, the indicator will turn off.
When the instrument is powered on and powered through the AC/DC adapter, the internal battery is automatically recharged. 
The icons mean the following:

When the 930XC is powered off and powered through the AC/DC adapter, the “CHARGE” indicator on the interface panel    
(Figure 2-1) will be lit. When the battery is fully recharged, the indicator will turn off.
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Section 4. Trace Measurement and Processing of Existing
Traces

Graphical User Interface (GUI) Instructions
When the 930XC is first turned on, an introductory screen appears on the LCD (Figure 4-1).

Three seconds after the instrument is turned on, a quick reference screen appears (Figure 4-2).

Trace Measurement
One complete trace can be obtained for each measurement. The 930XC can also load a saved trace.

Instrument damage hazard:
Make sure that the optical fiber or cable is not in use and there is no laser beam in the fiber before 
testing with this unit.
Failure to observe this precaution may result in injury and may damage the unit.

930XC-XXX

Figure 4-1. Power On Screen

Figure 4-2. Quick Reference Screen
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Setup
Connect the optical fiber directly to the 930XC optic output. No tools are required.

• Clean the connectors. Refer to Section 5 of this manual for details.
• Clean the tie-ins, making sure they are compatible (APC or UPC).
• Connect optical fiber to the 930XC.

For details relating to parameter configuration, refer to “Parameter Configuration” in Section 3. If the parameters are unclear, use 
the default parameters of the instrument.
Note: Range is set to “Auto” when auto measurement is on.

Auto Trace Measurement
Auto measurement can be used if the length of optical fiber is unknown. The 930XC will select an adequate range for 
measurement.
For auto measurement follow these steps:

1. Set the range to “Auto.” Refer to “Parameter Configuration” in Section 3.
2. Press Run/Stop to start the measurement (Figure 4-3).

Note: After a certain period of time, the trace displays on the GUI. The trace in the figure below is a trace during measurement, 
which will be refreshed for every certain period of time to demonstrate the whole process in realtime. But at the end of 
measurement the trace will be complete, as shown in Figure 4-4.

Figure 4-4. Trace Measurement

Figure 4-3. Measuring

3. Interface:
• Ave. Time: 00:30: Measure time, which is set by user, is 30 seconds.
• Time Elapsed: 00:16: Total measurement time has passed 16 seconds.
• : Blinking of this icon means laser is active.
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Manual Trace Measurement
To achieve optimal measurement results, set the parameters manually.

1. Set the range. Refer to “Range Configuration” in Section 3.
2. Press Run/Stop to start the measurement. The process is the same as with auto measurement.

Live Traffic Warning
Connect the optical fiber directly to the 930XC optic output. No tools are required.If the 930XC is connected to a fiber with live 
traffic, the warning of “Traffic Signal Detected!” will be displayed after Run/Stop is activated. Disconnect the fiber under test and 
quit the measurement. To avoid damage to the 930XC, ensure that live traffic is removed from the test fiber before reconnecting 
to the 930XC.

Reasons for Trace Measurement Failures
Figure 4-5. Live Traffic Warning
If measurement failures occur, the reason may be one of the following:

• Events may be too close to each other: Shorten the pulse width and try again. If failure still occurs, try measuring at 
the other end of the optical fiber.

• Low SNR: Use a wider pulse or increase average time and try again.
• Incorrect parameter configuration: Check the parameter configuration and try again.

Information Window
The information window displays the following items: measurement parameters, analysis parameters, and information regarding 
marker A/B.
For details regarding the information window, refer to “Information Window” in Section 3. 

Switching between Information Window Items
Under GUI (Figure 4-4) press   and the items in the information window will display in this order: measurement parameters g 
analysis information g events list g marker A/B information g fiber information g measurement parameters.

Reviewing Events List
Under GUI (Figure 4-4) press  until the events list information appears in the information window.
Use p and q to highlight # or $, and then press Enter to review the events list. Use # to browse upward, and $ to browse down-
ward. To browse up and down the events list using the keypad, press Shift + and Shift + Enter. 

Reviewing Marker A/B Information
Switching between Marker A/B
Under GUI (Figure 4-4) use p and q to highlight A/B, and then press Enter to switch betweeen marker A/B.
Use t and u to move marker A or B.

Figure 4-5. Live Traffic Warning
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Information between Marker A/B
Under GUI (Figure 4-4) press   to switch information window to marker A/B information. 

Use t and u to move marker A or B.

Zoom a Trace
Zoom out Trace Horizontally
To review the details of an event more closely, follow these steps:

1. Under GUI (Figure 4-4) use p and q to highlight , and then press Enter to zoom out the trace horizontally.
2. Use t or u to move the marker to the event point being reviewed.
3. Refer to “Switching between Marker A/B” above for more information. 

Zoom in Trace Horizontally
Under GUI (Figure 4-4) use p and q to highlight , and then press Enter to zoom out the trace vertically.

Zoom out Trace Vertically
To review the details of an event more closely, follow these steps:

1. Under GUI (Figure 4-4) use p and q to highlight   , and then press Enter to zoom out the trace vertically.
2. Use t or u to move the marker to the event point being reviewed.

3. Refer to “Switching between Marker A/B” above for more information.

Zoom in Trace Vertically
Under GUI (Figure 4-4) use p and q to highlight   , and then press Enter to zoom in the trace vertically.

Zooming Shortcuts
• To zoom in horizontally using the keypad, press Shift + u.
• To zoom out horizontally using the keypad, press Shift + t.
• To zoom in vertically using the keypad, press Shift + p.
• To zoom out vertically using the keypad, press Shift + Enter. 

Re-analyze a Trace
If the test result at a certain threshold is not adequate, it can be re-analyzed using this function to change the threshold. This 
function can be effective while the OTDR is disconnected from the fiber.
Under the parameter configuration menu edit the threshold value, and then press  to exit the parameter configuration menu. 
Press    to re-analyze the trace. 

Save a Trace
When auto or manual measurement is finished, the measurement trace can be saved. The contents of a saved trace include the 
trace curve and related information of the trace.

1. Under GUI (Figure 4-4) use p and q to highlight   , and then press Enter to enter (Figure 4-6).

Figure 4-6. Save a Trace
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2. Input file name: Use p, q, t, and u to choose the alphanumeric characters one by one, and then press Enter to 
confirm. The filename can be a maximum of eight characters in length.

3. Save file: Use p, q, t, and u to highlight “OK,” and then press Enter to save.
4. Cancel saving file: Use p, q, t, and u to highlight “Cancel,” and then press Enter to cancel the save file operation.
5. Delete alphanumeric characters: Use p, q, t, and u to highlight “Delete,” and then press Enter to delete the 

characters.
6. Memory space: “118/1000” means that total memory space is 1000 files; 118 files have been saved so far. 

Browse Saved Traces
1. Under GUI (Figure 4-4) use p and q to highlight , and then press Enter to confirm (Figure 4-7).

2. Use p and q to highlight the trace, and then use t and u to choose “Open” or “Cancel.” Press Enter to confirm.
3. Memory space: “118/1000” means that total memory space is 1000 files; 118 files have been saved so far.

Alter Measurements in Realtime Testing
To alter measurements in realtime testing, follow these steps:

1. Use p and q to highlight  (i.e., parameter configuration), and then press Enter. A parameter box will appear at the 
bottom of the screen.

2. Use t and u to move to the parameter to be changed (Figure 4-9), and then press Enter.
3. Use p and q to change the value. Select “Averaging” to choose Averaging testing.
4. Press “OK” to exit the parameter configuration menu. 

Figure 4-7. Browse Saved Traces

Figure 4-9. Alter Measurements in Realtime Testing
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Power Meter, Laser Source, and VFL Settings
Optical Power Meter Settings

1. Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration” in Section 3. Use p and q to 
highlight “OPM”, and press Enter to enter OPM interface (Figure 4-10)

2. Use t and u to toggle between calibrated wavelengths. Press Enter to enter OPM measurement setting interface (Fig-
ure 4-11)

3. Use p and q to highlight the parameter to be adjusted, and press Enter to enable adjustment. Press t and u to adjust 
digit position, and press p and q to adjust the value. Press Enter again to confirm and press to exit setting.

Zeroing the Optical Power Meter
1. Isolate OPM port from outside light input with dust cap tightened securely.
2. Enter “Setup” and find “PM/LS”.
3. Enter “PM/LS” and select “OPM”.
4. In OPM interface, press Enter to find OPM popup menu.
5. Find “Zero”, and press Enter to zero the OPM. 

Figure 4-10. Optical Power Meter

!

Figure 4-11. OPM Measurement Setting



930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P

33Tempo Communications Inc. 1390 Aspen Way • Vista, CA 92081 USA • 800-642-2155

Stabilized Laser Source Settings
1. Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration” in Section 3. Use p and q to 

highlight “SLS”, and press Enter to enter SLS interface (Figure 4-12).

2. Use t and u to toggle between SLS working wavelengths. Press Enter to enter SLS setting interface (Figure 4-13).

3. Use p and q to highlight the parameter to be adjusted, press Enter to confirm, and press   to exit setting. 

Visible Fault Locator Settings
1. Enter PM/LS interface as described in “Power Meter, Laser Source, and VFL Configuration” in Section 3. Use p and q to 

highlight “VFL”, and press Enter to enter VFL interface (Figure 4-14). 

Figure 4-12. Stabilized Laser Source

Figure 4-13. Stabilized Laser Source Setting

Figure 4-12. Stabilized Laser Source



930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P

Tempo Communications Inc. 1390 Aspen Way • Vista, CA 92081 USA • 800-642-215534

2.  Use t and u to toggle between VFL working modes. Press Enter to enter VFL setting interface (Figure 4-15).

3.  Use p and q to highlight the parameter to be adjusted, press Enter to confirm, and press    to quit setting.

Figure 4-15. Visible Fault Locator Setting

 

930XC Link Viewer 

 

Display Mode

 

Events are presented by icons in link view, viewing each one of the events is the same as in trace view with the same hot 
keys. The symbol  indicates the selected event with event number. The overall fiber link information is shown in the black 
line pictorial above the event link with relative position marks (white vertical lines) and distance information (total length and 
location of selected event).

 

Macrobend Analysis will find events that are high losses at 1550nm and little or no loss at 1310nm. To activate this feature 
set the Wavelength setting to 1310+1550nm.

Link Viewer is a graphical way of presenting OTDR test results. The user can manually switch between Link Viewer mode and 
Trace mode by toggling the Display Mode setting as shown below.

The test settings in Link Viewer mode are the same as in Trace mode, parameters as Range, Pulse Width, Measuring Mode 
(Averaging/ Real Time), Time, IOR etc. need proper configuration for reasonable test results. The user can start a test either 
in Link Viewer Mode or Trace Mode. In Link Viewer mode, OTDR test results are presented in a way shown below.
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930XC Link Viewer 

 

Display Mode

 

Events are presented by icons in link view, viewing each one of the events is the same as in trace view with the same hot 
keys. The symbol  indicates the selected event with event number. The overall fiber link information is shown in the black 
line pictorial above the event link with relative position marks (white vertical lines) and distance information (total length and 
location of selected event).

 

Macrobend Analysis will find events that are high losses at 1550nm and little or no loss at 1310nm. To activate this feature 
set the Wavelength setting to 1310+1550nm.

Link Viewer is a graphical way of presenting OTDR test results. The user can manually switch between Link Viewer mode and 
Trace mode by toggling the Display Mode setting as shown below.

The test settings in Link Viewer mode are the same as in Trace mode, parameters as Range, Pulse Width, Measuring Mode 
(Averaging/ Real Time), Time, IOR etc. need proper configuration for reasonable test results. The user can start a test either 
in Link Viewer Mode or Trace Mode. In Link Viewer mode, OTDR test results are presented in a way shown below.

Events Summary  

      
Beginning of fiber

    Splice

    
Connector  / Coupler

    
Macrobend

    
End of  fiber

 

Events will be highlighted if the respective event is greater than the relevant setting in the Pass/Fail menu.

Pass/Fail Setup
Pass/Fail settings are accessed as shown below.

Ins. Loss
Measured events with insertion loss greater than this setting will be displayed red.
Reflectance
Measured events with reflectance greater than this setting will be displayed red.
Total Attn.
Measured links with a total attenuation greater than this setting will be displayed in red.
Total Loss
Measured links with a total loss greater than this setting will be displayed in red.
Total ORL (Optical Return Loss)
If the total ORL for the link is equal to or greater than this setting the link will be displayed red.
Thres. On/Off
Enable / Disable Pass/Fail function. On provides Pass/Fail analysis. Off disables the analysis.

Pass/Fail Settings
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Events Summary  

      
Beginning of fiber

    Splice

    
Connector  / Coupler

    
Macrobend

    
End of  fiber

 

Events will be highlighted if the respective event is greater than the relevant setting in the Pass/Fail menu.

Pass/Fail Setup
Pass/Fail settings are accessed as shown below.

Ins. Loss
Measured events with insertion loss greater than this setting will be displayed red.
Reflectance
Measured events with reflectance greater than this setting will be displayed red.
Total Attn.
Measured links with a total attenuation greater than this setting will be displayed in red.
Total Loss
Measured links with a total loss greater than this setting will be displayed in red.
Total ORL (Optical Return Loss)
If the total ORL for the link is equal to or greater than this setting the link will be displayed red.
Thres. On/Off
Enable / Disable Pass/Fail function. On provides Pass/Fail analysis. Off disables the analysis.

Pass/Fail Settings

Macrobend Analysis  
Macrobend Analysis will find events that are high losses at 1550nm and little or no loss at 1310nm. To activate this feature set the 
Wavelength setting to 1310+1550nm.

 

 
 

 
 

 
 

 

Use the Delta to set the Macrobend sensitivity. Lower Deltas will find progressively smaller Macrobends. Please note when 
single wavelength is selected, Delta is not available for setting. Macrobend analysis is not available in 1310nm and 1550nm 
measurements.

The screenshot below shows the same measurement in conventional Trace mode.



930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P

37Tempo Communications Inc. 1390 Aspen Way • Vista, CA 92081 USA • 800-642-2155

Macrobend Analysis  
Macrobend Analysis will find events that are high losses at 1550nm and little or no loss at 1310nm. To activate this feature set the 
Wavelength setting to 1310+1550nm.

 

 
 

 
 

 
 

 

Use the Delta to set the Macrobend sensitivity. Lower Deltas will find progressively smaller Macrobends. Please note when 
single wavelength is selected, Delta is not available for setting. Macrobend analysis is not available in 1310nm and 1550nm 
measurements.

The screenshot below shows the same measurement in conventional Trace mode.
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Section 5. Calibration and Maintenance

Electric shock hazard:

• Do not expose the unit to extremes in temperature or high humidity. Refer to “Specifications.”

• Turn the unit off, disconnect from power, and make sure the laser source is off before 
cleaning.

Failure to observe these precautions may result in injury and may damage the unit.

43930XC-20C • 930XC-20M • 930XC-30F • 930XC-30P Instruction Manual

Section 5. Calibration and Maintenance

Electric shock hazard:

• Do not expose the unit to extremes in temperature or high humidity. Refer to
“Specifications.”

• Turn the unit off, disconnect from power, and make sure the laser source is off before
cleaning.

Failure to observe these precautions may result in injury and may damage the unit.

Calibration Requirements
Calibration of the instrument is recommended every two years. Contact Tempo for proper 
calibration services.

Maintenance and Replacement of Batteries
The 930XC has two batteries: a NiMH battery to power the instrument and a realtime clock (RTC) 
battery for data retention.

Note: Recharge the battery prior to use if the OTDR has not been used for one month.

To replace the NiMH battery (Figure 5-1):

1. Remove the battery compartment cover.

2. Remove the battery and disconnect the battery connector.

3. Replace the battery with the Tempo supplied replacement battery. 

To replace the RTC battery (Figure 5-1):

1. Remove the NiMH battery as above.

2. Remove the RTC coin cell battery.

3. Replace using a CR1220. Insert the replacement coin cell with the positive side facing up.

Figure 5-1. Replacing Battery
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Cleaning
When necessary, clean the case, front panel, and rubber boot with a damp cloth. Do not use 
abrasives, harsh chemicals, or solvents.

Before Cleaning
• Make sure the power is off to the instrument.
• Make sure the laser source is off when cleaning any optical connectors.
• Make sure AC power is disconnected.

Cleaning Interfaces and Connectors
Interfaces must be kept clean. Isopropyl alcohol may be used to clean the optical output. Always 
replace the protective dust caps when the unit is not being used, and keep the protective dust caps 
clean. In addition, flanges must be cleaned periodically.

Notes:
• The diameter of optic core is 9 um, and the diameter of dust and other particulates ranges 

from 1/100 to 1/1000 um. Dust and other particulates can cover part of the optical end and 
therefore degrade the performance of the instrument.

• In addition, power density may burn dust into optical fiber and induce further damage 
(for example, 0 dBm optic power may produce about 16000000 W/m*m power density in 
single mode fiber). If this happens, the measurement will be inaccurate and damage will be 
irreversible.

Tools for Cleaning Interfaces and Connectors

• Optical fiber cleaner (for cleaning optical connectors)
• Optical fiber cleaning rod (for cleaning optical outputs)
• Optical fiber cleaning tissue (for cleaning optical interfaces)
• Isopropyl alcohol
• Paper tissue
• Cleaning brush
• Cleaning swabs
• Condensed air

Procedure for Cleaning Interfaces and Connectors

1. Unscrew the adapter from the bulkhead.

2. Carefully clean the bulkhead and the inside of the adapter.

3. Screw the adapter back onto the bulkhead.

Figure 5-2. Flange

Section 5
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Section 6. Specifications
MODEL 930XC-20C 930XC-30P 930XC-30F 930XC-20M

Wavelength (± 20nm) 1310/1550 1310/1490/1550 1310/1550/1625 850/1300

Dynamic Range (dB)a 35 38/37/37 38/37/37 21/24

Event Deadzone (m)b 1m 1m 1m ≤2.5m

Attenuation Deadzone 4.5m 4.5m 4.5m ≤12m

Pulsewidth 5, 10, 30, 100, 300, 1us, 2.5us, 10us, 20us 12, 30, 100, 275, 
1us/30, 100, 275, 1us, 

2us

Selectable Ranges (km) 0.3, 1.3, 2.5, 5, 10, 20, 40, 80, 120, 160, 240 0.1, 0.3, 0.5, 1.3, 2.5, 5,  
0/0.1, 0.3, 0.5, 1.3, 2.5, 

5, 10, 20, 40, 80

Average Time 15s/30s/1 min/2 min/3 min

Distance Measurement 
Accuracy

±(1m + 5 X 10-5 x distance + sampling space)

Connector Type PC or APC (interchangeable FC, SC, ST)

Reflection Detect Ac-
curacy

±4 dB

Attenuation Detect Ac-
curacy

±0.05 dB/dB

Measurement Data Stor-
age

1,000 test curves

Data Transmission RS-232/USB port

Visual Fault Locator (VFL) -3dBm; 650nm

Optical Power Meter 
(OPM)

InGaAs

OPM Wavelengths 850, 1300, 1310, 1490, 1550, 1625nm

OPM Range +6 to -70dBm (+6 to -60dBm 850nm)

OPM Display resolution 0.01dB

OPM MOD Identification 1kHz, 2kHz

Stabilized laser Source 
(SLS)

Wavelength same as selected in OTDR mode ≤ -7dBm

Power Supply NiMH chargeable battery/AC adapter

Battery Life Support over 8 hours operating on onecharge or over 20 hours standby

Operating Temperature -10° to 50° C

Storage Temperature -20° to 60° C

Relative Humidity 0 to 95% (non-condensing)

Weight 1.9 lbs. (0.87 kg)

Dimensions 7.7” H x 3.9” W x 2.4” L (196mm x 100mm x 64mm)

Compliance CE, FCC, UL

Fiber Analysis Software Version 3.2
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Stabilized Laser Source Module

Specification 930XC-20C 930XC-20M 930XC-30F 930XC-30P
Wavelength Same as OTDR working wavelength
Output Power (dBm) ≥ –7

Optical Power Meter Module

Specification 930XC-20C 930XC-20M 930XC-30F 930XC-30P
Calibrated Wavelength (nm) 850/1300/1310/1490/1550/1625
Power Range (dBm) –70 ~ +6 (–60 ~ +6 @ 850 nm)
Detector Type InGaAs
Display Resolution (dB) 0.01
Accuracy ±5% ±0.01 nW (±0.5 dB @ 850 nm)
MOD Identification 1 K, 2 K Hz

Section 6
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Section 7. OTDR Trace Viewer Software

Trace Viewer software is an application developed for the 930XC OTDR. It allows the previously 
stored measurement records in the instrument to be uploaded to a PC and to be displayed, saved, 
or printed. This software provides a convenient data management function, which includes: 
editing, analysis, browsing, saving, backup, printing, and ASCII format output.

Software Installation

Computer System Requirements
Requirements for operating system and hardware:

• PC with Intel Pentium III processor or higher
• Microsoft® Windows 98/2000/XP/Vista/7/8 operating system
• Minimum 64 MB of internal memory
• Minimum 40 MB of available hard disk space
• 8-speed CD-ROM drive
• 9-pin series port or USB port

Installation
Follow these steps to install the 930XC OTDR Trace Viewer software on a PC:

1. Start Microsoft® Windows.

2. Exit all other running applications that Windows is currently running.

3. Insert the installation disk into the CD-ROM drive, and locate the OTDR Trace Viewer folder.

4. Run 930XC OTDR Trace Viewer setup file to install.

5. Follow the step-by-step installation wizard instructions until installation is complete.
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Menu, Tool Bar, and Status Bar
The main GUI of the 930XC OTDR Trace Viewer software is shown in Figure 7-1.

The menu bar includes: File, Edit, View, OTDR, Window, and Help.

The tool bar is right below the menu bar. Use the mouse pointer to highlight a tool, and the 
operation reference will pop up. The tool bar display can be turned on or off by clicking “Show 
Toolbar” under the “View” menu. The tool bar provides shortcut keys to complex operations. All 
the functions on the tool bar can also be accessed through the menu bar.

The status bar is at the very bottom of the GUI. It displays information or reference of the current 
menu or tool bar application. The status bar is a brief summary of the current menu application or 
tool bar function.

File (F)

The functions enabled under the “File” menu (Figure 7-2) include: Upload Trace File, Open, 
Multi-traces (add up to four traces to display) , Save, Save As, ASCII Export, Print Option, 
Printing Preview, Print, Batch Print Preview, Batch Print, Batch Edit, and Exit.

Figure 7-2. File Menu

Edit (E)

Use the “Edit” menu (Figure 7-3) to edit the events list: Add Event, Modify Event, Delete Event 
and Edit Trace (optical fiber) Information. Optical fiber information is explanatory text relating 
to the trace file that users type in. For each measurement, users can save the measurement trace 
with the 930XC. This software provides an interface for text input. For each trace file, users can 
input related information (No. of cable, No. of fiber, type of fiber, beginning of fiber, end of fiber, 
manufacturer, and technician. With this information, users can identify the corresponding relations 
between trace file and fiber chain.

Figure 7-3. Edit Menu

Trace Viewer Software
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Menu, Tool Bar, and Status Bar
The main GUI of the 930XC OTDR Trace Viewer software is shown in Figure 7-1.

The menu bar includes: File, Edit, View, OTDR, Window, and Help.

The tool bar is right below the menu bar. Use the mouse pointer to highlight a tool, and the 
operation reference will pop up. The tool bar display can be turned on or off by clicking “Show 
Toolbar” under the “View” menu. The tool bar provides shortcut keys to complex operations. All 
the functions on the tool bar can also be accessed through the menu bar.

The status bar is at the very bottom of the GUI. It displays information or reference of the current 
menu or tool bar application. The status bar is a brief summary of the current menu application or 
tool bar function.

File (F)

The functions enabled under the “File” menu (Figure 7-2) include: Upload Trace File, Open, 
Multi-traces (add up to four traces to display) , Save, Save As, ASCII Export, Print Option, 
Printing Preview, Print, Batch Print Preview, Batch Print, Batch Edit, and Exit.

Figure 7-2. File Menu

Edit (E)

Use the “Edit” menu (Figure 7-3) to edit the events list: Add Event, Modify Event, Delete Event 
and Edit Trace (optical fiber) Information. Optical fiber information is explanatory text relating 
to the trace file that users type in. For each measurement, users can save the measurement trace 
with the 930XC. This software provides an interface for text input. For each trace file, users can 
input related information (No. of cable, No. of fiber, type of fiber, beginning of fiber, end of fiber, 
manufacturer, and technician. With this information, users can identify the corresponding relations 
between trace file and fiber chain.

Figure 7-3. Edit Menu

Trace Viewer Software

50

View (V)

The “View” menu (Figure 7-4) controls the display of the tool bar, status bar, marker operation 
and trace display (zoom in and out horizontally and vertically), and the display style of the trace.

Figure  7-4. View  Menu

A trace is composed of many dots. To review the details of a trace, zoom in by drawing square 
with mouse on selected trace area from upper left to lower right direction and zoom out by 
drawing square from any other direction.

Use “Analyze Insertion Loss” function to manually calculate the insertion loss of an event 
(Figure 7-5).

Figure  7-5. Analyze  Insertion  Loss

(Figure 7-6).

Figure  7-6. Analyze

Section 7

Lock Marker A and B to �x the distance between them.

Re�ectance

Use “Analyze Re�ectance” function to manually measure the re�ectance of re�ection event
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Use the “Length Units” setting to select meters, feet, or miles as the unit of measurement. 
Note: When the Trace Viewer application is opened, this setting defaults to the last unit of 
measurement selected.

View Preferences refers to the trace display styles. Trace can be displayed in dots or solid line; 
dashed line displays or not; selection of the event status bar.

OTDR (O)

The “OTDR” menu (Figures 7-7 and 7-8) provides a reanalysis function for acquired traces. 
Operator can modify IOR, Scatter Coefficient, and event thresholds (Non-reflection, Reflection, 
and End) per each wavelength to review correct results.

Figure 7-7. OTDR Menu

Figure 7-8. Trace Reanalysis

Window (W)

The “Window” menu (Figure 7-9) controls the display of the subwindows: trace window, events 
table window, parameter window, and fiber chain information. Tile function displays subwindows 
in a layout similar to Figure 7-1. Other submenus take the selected window as the current active 
window.

Figure 7-9. Window Menu

Help (H)

The “Help” menu (Figure 7-10) displays the version of the software.

Figure 7-10. Help Menu

Trace Viewer Software

Use the “Length Units” setting to select meters, feet, or miles as the unit of measurement. Note: 
When the Trace Viewer application is opened, this setting defaults to the last unit of measurement 
selected.
View Preferences refers to the trace display styles. Trace can be displayed in dots or solid line; 
dashed line displays or not; selection of the event status bar.
OTDR (O)
The “OTDR” menu (Figures 7-7 and 7-8) provides a reanalysis function for acquired traces. Op-
erator can modify IOR, Scatter Coefficient, and event thresholds (Non-reflection, Reflection, and 
End) per each wavelength to review correct results.
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and trace display (zoom in and out horizontally and vertically), and the display style of the trace.
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A trace is composed of many dots. To review the details of a trace, zoom in by drawing square 
with mouse on selected trace area from upper left to lower right direction and zoom out by 
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Use the “Length Units” setting to select meters, feet, or miles as the unit of measurement. 
Note: When the Trace Viewer application is opened, this setting defaults to the last unit of 
measurement selected.

View Preferences refers to the trace display styles. Trace can be displayed in dots or solid line; 
dashed line displays or not; selection of the event status bar.

OTDR (O)

The “OTDR” menu (Figures 7-7 and 7-8) provides a reanalysis function for acquired traces. 
Operator can modify IOR, Scatter Coefficient, and event thresholds (Non-reflection, Reflection, 
and End) per each wavelength to review correct results.

Figure 7-7. OTDR Menu

Figure 7-8. Trace Reanalysis

Window (W)

The “Window” menu (Figure 7-9) controls the display of the subwindows: trace window, events 
table window, parameter window, and fiber chain information. Tile function displays subwindows 
in a layout similar to Figure 7-1. Other submenus take the selected window as the current active 
window.

Figure 7-9. Window Menu

Help (H)

The “Help” menu (Figure 7-10) displays the version of the software.

Figure 7-10. Help Menu

Trace Viewer Software
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Information Subwindows

Trace Display Window

Click “Open…” under the “File” menu to open a trace file, and a trace curve will display in the 
trace display window (Figure 7-11). The x-axis displays the distance (km); the y-axis represents 
the backscatter power (dB). There are two markers, A and B; click either one to activate it. To 
move the marker, click and drag with the mouse pointer; the position information will change 
accordingly. By moving the marker, the horizontal distance and vertical power can be read 
manually. Zooming in and out of the trace features depends on the activation of a marker. In 
Figure 7-11 below, the sloped line represents backscatter from the optical fiber. The peaks are 
reflective events in the fiber chain. The end of the fiber is shown by the sudden drop in optical 
power, which is followed by noise. The symbols at the bottom of the window indicate the type of 
event.

Figure 7-11. Trace Display

Events List Window

Trace data collected by the 930XC will be processed automatically, and analysis results will be 
displayed in the events list (Figure 7-12).

Figure	7-12.	Events	List

The events list contains the following items:
• No.: Sequence of events in optical fiber chain.
• Type: Beginning, end, reflection, and non-reflection event.
• Distance: Distance from OTDR to event point.
• Reflection	Value:	Value of reflection event.
• Insertion	Loss:	Vertical decline of dB.
• Attenuation	Coefficient:	Value of attenuation per kilometer between current event point and 

previous event point in optical fiber chain.
• Cumulative	Loss:	dB value of loss from 0 km to current event point.
• Dist.	Prev.	(km):	Distance from the previous event.

Section 7
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• Dist.	End.	(km):	Distance from the end event.
• Loss	Prev.	(dB): Loss from 0 km to current event point.
• Comment: Notify other details of the event.

Parameter Window

The parameter window (Figure 7-13) displays the default parameters of the currently displayed 
trace. Measurement parameters include: range, pulse width, average time, and wavelength. 
Analysis parameters include: IOR, scattering coefficient, end threshold, non-reflection threshold, 
reflection threshold, and samp. dist. For definitions of these parameters, refer to “Parameter 
Configuration” in Section 3 of this manual.

Figure 7-13. Parameters

Fiber Section Information Window

This window (Figure 7-14) displays the distance between marker A and B, attenuation coefficient, 
and loss information. The two point loss is the difference of vertical power between marker A and 
B. Two point attenuation is the two point loss of marker A and B divided by the horizontal distance 
between marker A and B.

Figure 7-14. Fiber Section Information

Trace Viewer Software
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Fiber Chain Information Window

The contents displayed in this window (Figure 7-15) are date of measurement, length of fiber 
chain, loss of fiber, attenuation, ORL, and event number of fiber.

Figure 7-15. Fiber Chain Information

Software Functions

Upload Trace Data

Option 1: 

Power off the 930XC, and then connect the 930XC to a PC via USB cable. Turn the 930XC on 
and wait for PC to recognize 930XC as an USB memory device. Find “trace” folder to copy saved 
files to PC. 

Option 2:

Power off the 930XC, and then connect the 930XC to a PC via serial cable. Turn the 930XC on 
and run the 930XC OTDR Trace Viewer software. Under the “File” menu, select “Upload trace 
file…”, and the “Communications Settings” dialog box appears. Choose a communication port 
(RS-232) and click “OK”. Choose the saved position of traces, and then start uploading data.

Figure	7-16.	Upload	Trace	Data

Section 7
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Browse Traces

Tool Bar

Move the mouse pointer over the tool bar and an explanation of the buttons will pop up.  
Their functions are as follows:

 Open file

 Close file

 Save file

 Printing preview

 Printing

 Edit optical fiber information

 Zoom out trace

 Display whole trace

 Zoom in trace horizontally

 Zoom out trace horizontally

 Zoom in trace vertically

 Zoom out trace vertically

 Analyze insertion loss (the five-point measurement to test the insertion loss)

 Analyze reflectance

 Lock marker A and B

 Display version

 Trace number (in multi-trace display mode)

Trace Viewer Software
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Trace Parameter

Measurement parameters and analysis parameters display in the parameter window (Figure 7-18).

Figure 7-18. Parameters

Fiber Section Information

The distance between marker A and B should be considered as one section of optical fiber  
(Figure 7-19).

Figure 7-19. Fiber Section Information

Fiber Chain Information

The distance from beginning to end should be considered as a fiber chain (Figure 7-20).

Figure 7-20. Fiber Chain Information

Trace Viewer Software
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Review	Events	List

The trace curve decreases at a fixed slope. Any sudden peak or drop should be considered an 
event. The 930XC acquires measured data automatically and creates the events list (Figure 7-21).

Figure	7-21.	Review	Events	List

For details relating to the events list, refer to “Events List Window” in this section.

Save Trace
Opened trace files can be saved in the same manner as other files. Click “save trace file” under the 
“File” menu to save a trace with an existing file name. Click “save as trace file” under the “File” 
menu to save a trace with a new file name.

ASCII Format Output
Trace Viewer software provides a software interface so that data can be exported in ASCII format 
and then opened and viewed by a third-party application like MS Excel.

Select “ASCII format output” under the “File” menu (Figure 7-22). Select the information and 
format, and then press Enter to choose the path and file name.

Figure 7-22. ASCII Format

Edit Optical Fiber Information
Select “Edit information of optical fiber” under the “Edit” menu, or click  to start editing 
optical fiber information (Figure 7-23). Information of optical fiber is a description of 
measurement trace displayed in the trace window. Users input relevant information for efficient 
management of measurement files. Upon completion of editing, press Enter to confirm.

Figure 7-23. Edit Optical Fiber Information

Section 7
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Revise Events List
Because field measurement situations are constantly changing, the 930XC analysis software 
cannot guarantee that every analysis is correct. The software provides an interface for users to 
revise the events list: add event, revise event, delete event, and delete events list.

Add Event

If an event on the measurement trace is not listed in the events list (due to inaccuracies caused 
by poor SNR or inadequate parameter configuration), use the “add event” function to manually 
add this event into the events list. Click the events list window, and select “Add event” under the 
“Editing” menu (Figure 7-24). Choose the type of event from the pull-down menu, enter the event 
features, and then press Enter to add the event to the events list.

Figure 7-24. Add Event

Revise Event

Use the “revise event” function to manually revise features of an event (due to inaccuracies caused 
by poor SNR or inadequate parameter configuration). Select the event to be revised in the events 
list window, and select “Revise event” (Figure 7-25). After modifying the event feature(s), press 
Enter to confirm the changes. The software will automatically refresh the event sequence.

Events can also be revised by clicking on the event to access a pop-up menu.

Figure 7-25. Revise Event

Delete Event

Use the “delete event” function to manually delete a trace from the events list when it appears in 
error (due to inaccuracies caused by poor SNR or inadequate parameter configuration). Highlight 
the event to be deleted, and then select “Delete event” under the “Editing” menu. 

Events can also be deleted by clicking on the event to access a pop-up menu.

Trace Viewer Software
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Printing

Printing Options

Select “Printing options…” under the “File” menu (Figure 7-26), to select the contents to be 
printed.

Figure 7-26. Printing Options

Printing Setup

Select “Printing setup” under the “File” menu (Figure 7-27) to select the printer, paper size, and 
printing orientation.

Figure 7-27. Printing Setup

Section 7
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Batch Edit

The 930XC Trace Viewer software has a batch-edit function that allows users to edit the trace 
information of several trace files in the same folder at one time. Select “Batch Edit” under the 
“File” menu (Figure 7-30).

Figure 7-30. Batch Edit

Batch Print

The 930XC Trace Viewer software has a batch-print function that allows users to print several 
trace files in the same folder at one time. Select “Batch Print” under the “File” menu (Figure 7-31).

Figure 7-31. Batch Print

Section 7
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Exit Software
Press “Exit” under the “File” menu (Figure 7-33) to exit the Trace Viewer software.

Figure 7-33. Exit Software
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